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About this Document
This document is a guide for the just:live user. It contains all necessary information on how to use the 
just:live user interface. We make these assumptions:

ρρ You are familiar with the Macintosh environment.
ρρ The just:live system has been properly configured by your system administrator.
ρρ The system has been properly tested and no errors have occurred during the testing period.
ρρ After reading this document the user understands how to use just:live.
ρρ The user is aware of the third party hard- and software used with the same system.
ρρ The user knows how his particular channel is configured and how to use the specific functions.
ρρ The user knows how to react if a problem occurs, has access to the support system and knows how 

to report a bug or feature request.

1  About the just:live Interface 
The just:live graphical user interface (also called "just:live UI") represents a simple way to add videos 
and graphics (such as inserts, tickers or information templates) to your live rundown. Videos and 
realtime graphics can be collected in a show long in advance, making it possible that you only have to 
handle the footage needed during the production.
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2  just:live User Interface
just:live User Interface

Connecting to a Channel2.1 

Start the just:live application in the folder "/Applications/Just Live". The "Connect to channel…" window 
appears.

Choose a channel here and enter your username and pass
word. Click the "Connect" button to start the just:live UI with 
the selected channel activated.

To use the internal channel, select "Built-in Channel" from the 
channels drop-down box. If the "Built-in Channel" does not 
appear here, just:out is already started on this machine and 
therefore using the "Built-in Channel" is not possible.

Using the "Built-in Channel" is for testing purposes only. This kind of channel is much easier to setup 
and you can see the "On Air" window directly in the user interface. However, a crash of the application 
would stop the playout. Needless to say, all functions provided by just:connect (multi channel, multi 
concurrent control, user control, etc.) are not available.

Note

You will get a warning if access is denied. If you see a message beginning with one of the 
following words please contact your system administrator.
ρρ Message 1: Sorry, User…
ρρ Message 2: Sorry, Interface Client…
ρρ Message 3: This channel is only for use with just:live!

Once the just:live UI has been started it will gather the channel information from just:connect (or 
initialize the "Built-in Channel") and present the information through the user interface to you. 

just:live User Interface

Managing Channel Connections2.2 

By clicking on the sprocket icon you can flip the login window. 
Here you can define fixed hosts to which you may want to 
connect. 

This kind of setup should have been done by your system 
administrator. Please contact your administrator before 
making any changes.
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just:live User Interface

Preferences2.3 

The actual setup and configuration of a channel is done in just:connect by your system administrator. 
The whole channel is defined there (number of activated layers, usage of a FX layer for the station ID 
("bug"), user permissions for a particular channel, etc.). But there are also some settings which are 
related to the just:live UI installed on a particular machine. To configure a copy of just:live, open the 
preferences dialog in the menu "Just Live » Preferences".

1
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1 Live feed input
Depending on the hardware setup done by your system administrator, a video device will be 
selected in this drop-down box. This video device receives a video signal which will be shown in 
the "On Air" window. Do not select a video device here which is already used by just:out. Contact 
your system administrator if you are unsure.

2 Live feed left of preview
When enabled, the "Preview" and "On Air" windows are swapped.

3 Show names for all items in timeline
When enabled, the name labels of all clips in the timeline are always displayed. When disabled, 
the clip names in the timeline are only displayed when hovering above them with the mouse.

4 Show tooltips in the library
Activating this option gives you additional information about an item in the library when you 
hover above it with the mouse for a short period of time. Disable this feature if you do not need 
tooltips.
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5 Default next action for movies
This option allows you to predefine the default end action for every video which is dropped into 
the workbench. This preset can be overruled later for each video element using the inspector.

6 Hold time for 'Hold and Cue Next'
This setting allows you to define how long the last frame of a video will be "held" before the next 
clip will be cued.

7 Hold time for 'Hold and Play Next'
This setting allows you to define how long the last frame of a video will be "held" before the next 
clip will be played.

8 Default next action for graphics
This option allows you to predefine the default end action for graphic elements which are dropped 
into the workbench. This preset can be overruled later for each graphic element using the inspector.

9 Enable VDCP server on serial port
Enables the "Video Disk Control Protocol Server" (also see appendix "VDCP Support"). Contact 
your system administrator for the proper settings (depending on the serial device you want to 
use).

10 Poster frames cache
This defines the folder where poster frames will be saved. By default the poster frames are saved 
in the folder "Poster Frames" inside of the "Documents" folder of the current user. This option is 
enabled by default. Disable it to suppress the creation of new poster frames in the workbench of 
just:live.

11 Default video in-point
This option is disabled by default. Enable it to enter a timecode value. Once enabled, the in-point 
of QuickTime movies which are dragged from the library into the workbench will be set to the 
specified value (assuming that the QuickTime movie contains timecode). This is useful if all of 
your QuickTime movies contain a trailer or countdown before the actual video content starts.

12 Play video command on GPI input #
Here you can define the GPIin which should execute the play command.

13 Workbench double-click action
Only available when the workbench is in list mode. This defines the 
action which is executed when double-clicking an element in the 
workbench. The options are visible in the image on the right.

14 Reset all dialog warnings
Pressing the "Reset" button enables dialog warnings again.
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just:live User Interface

Overview2.4 

Preview, Timecode  
and Buffer Area

Timeline

Library

Workbench/Instant Interface

Inspector

2

3

1

4

5

1 Library
Divided in four tabs, the library shows QuickTime movies, graphic elements, events and saved 
playlists. Related metadata will also be shown (if available). A search field and the possibility to 
show a preview window complement the library.

2 Preview, Timecode and Buffer Area
The "Preview" window is on the left and the "On Air" window on the right. Use the "Preview" window 
to preview a selected video clip or to define a new in/out-point for a selected video clip (using 
the yellow trimmer). The "On Air" window shows – depending on whether you are connected to 
the "Built-in Channel" or a just:connect channel – the final output (including the timecode and the 
buffer status) or only the timecode.

3 Timeline
Shows all video clips, graphic elements and events loaded or already playing out (including the 
element names, the elapsed/remaining time info and the layers' "Play" buttons). The layer visibility 
is defined from top to bottom. 

4 Workbench/Instant Interface
This is the place where video clips, graphics, etc… are collected for the final playout. Folders can 
help you to organize and manage complex shows. You can choose between the list view and the 
poster frame view. Use the view which fits your needs best.

5 Inspector
Here you can modify attributes of one or multiple selected elements.
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just:live User Interface

Library2.5 

1

2

3

4 6

5

1 Tabs
The "Video" and "Graphic" tabs show the content of the video/graphic repository folders (which 
were defined by your system administrator in just:connect). The third tab is labeled "Event" and 
displays router controls (if such controls are available). The fourth tab labeled "Playlists" displays 
the contents of the playlist repository folder defined in just:connect. You can drag a playlist from 
the library and drop it into the workbench to add the content of the playlist to the show. Playlists 
previously defined in just:live and Final Cut Pro XML playlists are supported.

2 Repository Folder View
Displays the content of the repository folders in a similar fashion as the Finder's list view (including 
media related metadata). You can scroll vertical to see all items stored in the repository folders 
and horizontal to see the media related metadata. Move the mouse to the beginning of a column 
separator, click-hold the mouse button and move the mouse to the left or right to change the 
column width. Click-hold a column header and move the mouse left or right to change the order 
of the columns. In the library it is not possible to remove columns.

3 Preview
Preview of selected video or graphic. Use the "Preview" button to show or hide the preview 
window. 
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4 Search Field
Allows you to search for files. Click on the magnifying glass to select the metadata field you want 
to browse. After typing in a text, only elements which match this text will be shown in the library. 
Note that the search is also tab related which means that the search field is usable for each tab 
separately.

5 Library Preview Button
Press this button to show or hide the library preview window. You can use the mouse wheel or 
the "Preview" window to scrub through a video file. You can not set an in/outpoint here. 

just:live User Interface

Preview Area2.6 

6

7

8

1 43

2 5

1 In-Button
Defines the in-point of a video clip. You can also use the yellow trimmer to define the in-point by 
using your mouse (click-drag).

2 Go to In-Point
Moves the CTI to the defined in-point.

3 CTI Position
Shows the timecode of the CTI position.

4 Go to Out-Point
Moves the CTI to the defined out-point.

5 Out-Button
Defines the out-point of a video clip. You can also use the yellow trimmer to define the out-point 
by using your mouse (click-drag).

6 Trimmer and CTI
The yellow trimmer is a visual representation of the in/out-point. When dragging a video clip 
from the library to the workbench, the "active play" area marked in QuickTime Player is used to 
automatically set the video's in- and out-point. Using the blue CTI you can scrub through the 
video, which allows you to get a better overview.
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7 Control

  Rewind					      Step one frame backward

  Play/Pause				      Step one frame forward

 F ast forward				    	 Play selected range

8 Timecode Information Overlay
When using the "Built-in Channel", this overlay shows the buffer status and the name of the 
channel you are connected to. The timecode overlay shows the current time, elapsed time or 
remaining time. Click it to switch modes.

just:live User Interface

Preview Area + Built-in Channel2.7 

When using the "Built-in Channel", the "On Air" window shows the 
engine's output (all videos and graphic elements but not the incoming 
live video signal). Also, the "On Air" window is overlaid with the buffer 
status and the timecode information.

just:live User Interface

Preview Area + just:connect Channel2.8 

When using a channel administered by just:connect, there will be 
no "On Air" window showing the engine's output. Instead, a floating 
just:live timecode window will be shown.

If you want to see the actual engine output and the engine's buffer 
status, you need to activate the "Preview" and "Diagnostics" window in 
the just:out you are connected to.

just:live User Interface

Buffer Status2.9 

When using the "Built-in Channel" you see the buffer status 
bar inside the "On Air" window.

Green buffer status is good but if the buffer reaches the red range, it should recover in time, otherwise 
the playout will stagger. Please consult your system administrator for further information.
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just:live User Interface

Timeline2.10 

1

9

842 73 5

10

6

1 Layer Name
Each layer has a name. Your system administrator can change the names in just:connect.

2 Elapsed Time
Elapsed time of an element.

3 Element Name
Displays the name of the currently active element

4 Poster Frame
Shows (if available) the poster frame of an element.

5 CTI
Current time indicator, indicates the current position.

6 Video Element
A video element.

7 Remaining Time
Remaining time of an element.

8 Hide Layer Buttons
Clicking the  icon toggles the "hidden" attribute of a layer. Visibility of hidden layers can be 
changed in the menu "Window » Show Hidden Layers"

9 Timeline Ruler
The scale of the timeline ruler can be changed by using your mouse wheel while hovering above 
the timeline's ruler. The timeline can either be static or rolling ("Window » Static Timeline Ruler"). 
In static mode the timeline ruler description starts with zero, in rolling mode the description 
equals the engine time.

10 Graphic Element
A graphic element.
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just:live User Interface

Workbench Views2.11 

just:live provides two different views to organize and view your elements which are ready for being 
aired. The following chapters explain the differences and functions.

List View "Instant Interface" View

just:live User Interface

Workbench Views: List View2.12 

1 2

7 8 9 10 11

4

6

3

5
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1 Folder List
You can create folders to organize files. Click the "+" button to add a folder or press the backspace 
key to remove a selected folder.

2 Element List
Lists the content of the currently selected folder.

3 Play Element 
The green status means that the element is scheduled. Clicking the status button airs the element. 
Holding down the command key while clicking the "Play" button cues the first frame instead of 
playing the clip. This also works while the clip is playing out.

4 Selected Element
Clicking this status button adds the corresponding element to the timeline.

5 Loaded Element
The yellow status means that the element is scheduled. It has to wait until the preceding elements 
have finished. Each element of this type has a number beside it which indicates the scheduled 
order.

6 Element
This element is not selected and not scheduled.

7 Folder View Button
Click this button to hide or show the folder list.

8 Add Folder
Click this button to add a folder. Use the inspector to rename folders.

9 Item Count
Displays the item count of the currently selected folder.

10 List View
Toggles the list view.

11 "Instant Interface" View 
Switches to the "Instant Interface" view.
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just:live User Interface

Workbench Views: "Instant Interface"2.13 

1 2

3 7

4 5 6

1 Folder List
You can create folders to organize files. Click the "+" button to add a folder or press the backspace 
key to remove a selected folder.

2 Poster Frames 
Shows the content of the selected folder, where each element is displayed with its poster frame. 
The different symbols and colors are explained in the next chapter.

3 Folder List Button
Click this button to hide or show the folder list.

4 Add Folder
Click this button to add a folder. Use the inspector to rename folders.

5 Poster Frame Size
Use this slider to adjust the poster frame size.

6 List View
Switches to the list view.

7 "Instant Interface" View 
Toggles the "Instant Interface" view.
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just:live User Interface

"Instant Interface": Poster Frame States2.14 

The instant interface uses different symbols and colors to display the content of your folders and the 
states of their containing elements.

Not Selected
Represents a video/graphic which is not selected.

Selected
Represents a video/graphic which is selected. Clicking the arrow inside loads 
the element on the target layer you have defined in the inspector. 

Not Selected & Ready to Play
Represents a video/graphic which is scheduled. This element is not selected 
and ready to play. Clicking the play button inside airs the element.

Selected & Ready to Play
Represents a selected video/graphic which is scheduled. Clicking the play 
button inside airs the element.

Following Item
Represents an element which is scheduled but currently not on air. Each element 
of this type has a number inside which indicates the scheduled order.

Playing
This element is currently on air.
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FX Layer
This additional number in the upper right corner of a graphic element shows the 
layer in which the element will be loaded. This will not be shown if only one FX 
layer is activated for this channel.

Video Layer
This additional number in the upper right corner of a video clip shows the layer 
in which this element will be loaded. This will not be shown if only one video 
layer is activated for this channel.

 

just:live User Interface

Inspector: Standard Attributes, Video & Audio2.15 

1

2

4

3

5

6

1
Standard Attributes
Default attributes of a selected element.

2
Video
Several video specific attributes.

3
Slow Motion
Allows you to set the playback speed of a video 
clip (25 %, 33 %, 50 %, 66 %, 75% and 100 %).

4
Audio
Several audio specific attributes.

5
Control
Several control specific attributes.

6 "Fast Access" Button
ρρ Playlist is selected: The button allows you 

to save the selected playlist.
ρρ Graphic is selected: The button allows you 

to reset all input ports (= reset all attributes 
to their default value).

ρρ QuickTime movie is selected: The button 
allows you to split the clip.

ρρ Still image is selected: The button is 
disabled.
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1  Standard Attributes

ρρ Name: Can be used to change the name of a selected element.
ρρ In/Out Point: Defines the in/out-point of a selected element.
ρρ Duration: Allows you to control the duration of a selected element.
ρρ Color: 

  An element may have a color defined by selecting it in 
the inspector. The color of each element is also shown in a column in the workbench (if this 
column is enabled). When dragging and dropping elements from the library, the "Finder" color (if 
defined) will automatically be set for the element and shown in the workbench.

2  Video

ρρ Fade In/Out: Videos can fade-in or fade-out up to 10 seconds from and to black.
ρρ Cross Fade: When enabled, video clips cross fade from the "live" video input at the start and back 

to the "live" video input at the end (according to the "Fade In" and "Fade Out" settings). When not 
enabled, a video clip with fade-in or fade-out will fade from or to black instead of the live video input.

ρρ Invert Fields: When enabled, video fields are inverted. DV PAL footage uses lower field first. This can 
be changed during playout of the selected clip and will be executed immediately depending on the 
video buffer set in just:out preference pane by your system administrator.

ρρ Aspect Conversion: Defines how to handle the aspect ratio of the selected QuickTime movie. Your 
system administrator should already have a setting predefined in the just:out preferences. Several 
options are available depending on the direction of the conversion. For a visual description please 
refer to the chapter "Aspect Ratio Control" in the appendix at the end of this document. 

3  Slow Motion

ρρ Playback Speed: This setting allows you to play the video at a slower frame rate than the original 
frame rate. Select the speed here or use one of the available shortcuts which you can find under the 
"Edit" menu.

ρρ Deinterlace: Choose if the selected clip should be deinterlaced when slow motion is enabled.

4  Audio

ρρ Fade With Video: When enabled, the audio will automatically fade with the video's fade-in and fade-
out settings. 

ρρ Volume: Allows you to adjust the volume of a selected video clip with a value between 0 (muted) and 
1 (full volume).

ρρ Live Volume: The "Live Volume" attribute is the same as the "Volume" attribute but relates to the 
volume of the live input. By default, the "Volume" attribute is set to 1 (full volume) and the "Live 
Volume" property to 0 (muted).
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5  Control

ρρ Layer: just:live reflects the activated layer count for the active channel, so there can be multiple 
layers available for playout. If you have more than one video or FX layer, you can load an element to 
the layer of your choice. Select the element, then set the target layer you want to use in the inspector.

ρρ Finished Action: See chapter "Finished Actions".
ρρ Loop: See chapter "Finished Actions".

just:live User Interface

Inspector: Graphic Specific Settings2.16 

1

3
2

4

5

1 Text Field
Text in this field can be changed at any time. It accepts all characters.

2 Checkbox
A checkbox is a boolean value (it can be unchecked or checked, "false" or "true"). In this case the 
checkbox enables or disables a certain element inside of the selected graphic.

3 Slider
A slider can be used to define a value roughly. The exact slider value is displayed in the text box 
on the right of it. This text box can also be used to modify the slider's value. A slider value has a 
minimum and maximum value.

4 Number Variable
A number value which can be positive or negative.

5 Color Value
Clicking on the colored bar opens a color picker.
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just:live User Interface

Finished Actions2.17 

An element can have a so called "Finished Action". You can 
set the "Finished Action" of an element in the inspector inside 
the "Control" section.

None Output switches back to live.
Play Next Automatically plays the next scheduled 

element.
Cue Next Cues the first frame of the next element.
Hold Last Holds the last frame.
Reload Reloads the clip, output switches to live input 

(not available when "Loop" is activated).
Recue Recues the clip and waits at the first frame 

(not available when "Loop" is activated).
Hold and 
Cue Next

Holds the last frame and cues the first frame 
of the next element after the predefined time 
(default 1 second)

Hold and 
Play Next

Holds the last frame and plays the next 
element after the predefined time (default 1 
second)

In addition to the "Finished Action" you can define that a clip 
should play in a loop. Doing so the clip will be on air until you 
disable the loop attribute (the clip will play until its end and 
will then execute the finished action) or until you click on the 
"Play" button (this will skip the remaining frames of the clip 
and executes the "Finished Action" immediately).
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3  Creating a Rundown
Make sure that the channel is ready by checking the following points (contact your system administrator 
if you are unsure).

or just:live is running with the "Built-in Channel"
ρρ just:out is running
ρρ just:connect is running

Network connection

Netw
ork just:out

just:connect

just:live UI

just:out

Creating a Rundown

Saving and Opening Shows3.1 

When you start the just:live UI, a new "Show" with the name 
"Untitled" is generated automatically. In a show, the status of 
the workbench and the timeline are saved and therefore can 
be recalled whenever needed. 

To save a show go to the "File" menu and select "Save" or "Save 
as…". To close the current show and open a previously saved 
show go to the "File" menu and select "Open…" (or select one 
of the shows shown under the "Open Recent" menu). 

Changing the show is only possible when there is no clip playing in the timeline. A warning will be 
displayed before the current show is closed.
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Creating a Rundown

Defining the Default Attributes of a Folder3.2 

To define the attributes of a folder, select the folder in the 
workbench and define the attributes in the inspector. In 
addition to the attributes of the folder itself you can also 
predefine the layer selection and the default finished action 
for each video and graphic element dropped into that folder.

Activating the "Playlist" option adds a playlist icon besides 
the folder name in the workbench. Clicking once on this icon 
loads all elements into the timeline in the order in which they 
are listed in the workbench. This feature is very useful if you 
want to load several elements into the timeline with a single 
click. This feature is only available when using the list view in 
the workbench.

Creating a Rundown

Adding and Removing Folders3.3 

A show can have one or several folders. As in the operating 
system, a folder allows you to add a logical structure to your 
data by separating and collecting items into different folders. 
You can add a folder by pressing the "+" button at the bottom 
of the folder list in the workbench, or by selecting "New 
Folder" under the "File" menu.

To remove a folder from the show (including the items within the folder), select the folder and press the 
backspace key on your keyboard. The items within the folder will not be deleted from the disk.
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Creating a Rundown

Adding an Element to the Workbench3.4 

In order to play out videos, graphics or to send GPI/Router commands you first have to drag them from 
the library and drop them into the workbench – as demonstrated in this screenshot. 

Once dropped, they will be added to the list of videos, graphics and GPI/Router commands available for 
immediate usage. Above the workbench you see the timeline. Elements in the workbench can be loaded 
into the timeline and then played out.

Creating a Rundown

Loading Elements to the Timeline3.5 

Before playing out a video, graphic or sending a GPI/Router command you need to load the respective 
element to the timeline. This way you can build up small sequences of elements in the timeline before 
the playout of the videos and graphics starts. For example you could load several videos to the timeline, 
in which case they appear as a sequence in the timeline one after the other. Once you have loaded the 
elements you can then play the first video/graphic/command.
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In addition of loading elements into the timeline, you can also double click an element in the workbench 
which will immediately execute the action defined in just:live's preferences. In such case the options are 
"None", "Load", "Load and Cue" or "Load and Play". This function only works if there is no other element 
already loaded on the target layer.

Creating a Rundown

Using Videos on FX Layers3.6 

It is not possible to send a graphic element to a video layer. 
But there may be situations where you would like to play a 
video on a FX layer. To do this you can hold the command 
key while dropping the video into the workbench. This will 
display a dialog which allows you to treat the video like a 
graphic element.

Creating a Rundown

Video Preview and In/Out-Point Definition3.7 

Click on the video you want to preview to show it in the 
"Preview" window. Use the mouse, keyboard and/or an 
optional external device to control the preview. To set a new 
in-point, grab and reposition the yellow trimmer on its left 
end. To set a new out-point do the same on its right end. 

Once you have set a new in/out-point, the change will be applied immediately for the selected video.

Creating a Rundown

Multiselection of Elements in the Workbench3.8 

To change the attribute(s) of multiple elements (which are of 
the same type), select the elements in the workbench with 
your mouse while holding the shift key (selects a range) or 
the command key (adds another element to the selection). 

Now the shared attributes should be shown in the inspector and therefore any change of an attribute 
will be applied to all of the selected elements.
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Creating a Rundown

Duplicating Elements in the Workbench3.9 

Sometimes it is useful to duplicate elements in the work
bench. Imagine a lower third which should be played out 
several times but each time with a different name.

To make this happen, click on the element you want to copy 
and press command+c and then command+v. This makes 
a new copy of the selected element every time you press 
command+v.

After that you can change the elements' attributes using the inspector. Changing the names of the 
elements will allow you to recognize the elements when using them later on. 

Creating a Rundown

Splitting a Video Clip3.10 

Sometimes it can be useful to split a video clip, for example to add commercial breaks to a feature film.

To split a video clip, select it to show it in the "Preview" 
window. Move the CTI to the position you want to split the 
clip using the mouse, keyboard and/or an optional external 
control device. Now click on the "Split Clip" button at the 
bottom of the inspector.

Creating a Rundown

Cueing a Video Clip3.11 

In some situations it is necessary to show the first frame of the next video without starting the playout 
itself. This function is called "cueing" and can be achieved by defining a "Finished Action" which executes 
this automatically. In case the video clip is already loaded you can cue the first frame by holding down 
the command key while pressing the "Play" button. This cues the first frame of the video. To start the 
playout, the "Play" button has to be clicked a second time.
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Creating a Rundown

Playing Elements Consecutively3.12 

In just:live, by default each clip in the timeline does not start automatically when an earlier clip finishes. 
Instead, just:live goes back to the default output defined by your system administrator (black or live 
signal pass through).

Each clip waits at the CTI line for you to issue a play command – or trigger – for it to start. Thus, if you 
load five video clips into the timeline you will also issue five play commands to play them out – unless 
you define "Finished Actions". A play command is only valid if nothing is currently playing and there is 
an element waiting at the CTI line to be played out.

However, if you want to play several elements with a single play command, you can do this by setting 
the "Finished Action" attribute for each element in the inspector to "Play Next". By default this is "None", 
which means that the next element stops and waits at the CTI as described above. When set to "Play 
Next", the next element in the timeline is automatically started when the current element is finished 
without issuing a further play command.

Note

Usually each layer has to be started explicitly. However it is possible to execute actions 
on multiple layers at the same time by pressing the command key while clicking the first 
element of each layer. The play command will then be issued to all selected layers.

Creating a Rundown

Finished Actions in Detail3.13 

Each item in the workbench has a pre-assigned "default" layer to which it will be loaded. You can 
change the target layer in the inspector. By default all videos are assigned to the first video layer and all 
graphics are assigned to the first FX layer.

The "Play" button in the following screenshot shows the video waiting at the CTI line on the video layer. 
If a video is currently playing on a layer, clicking on the "Play" button executes the "Finished Action" 
immediately.  If a graphic element is currently waiting on a stopframe, clicking on the "Play" button 
releases the stopframe. In this case the graphic is released from the stopframe and continues to play 
until the next stopframe is reached or the graphic reaches the end.

1
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Creating a Schedule

Building GPI/Router Control Events3.14 

It is possible that your system administrator has already prepared events. If this is not the case or if you 
need other events, please contact your system administrator.

Creating a Rundown

Using GPI/Router Control Events3.15 

Using GPI and router control works the same way as using videos and graphics. First you have to 
switch to the "Event" tab. Your system administrator should already have prepared events for you. If this 
is not the case (i.e. the "Event" list is empty), please contact your system administrator.

Drop an event into the workbench. Select the event in the workbench and load it into the timeline. The 
event can be triggered as usual.

1 2

Creating a Rundown

Removing Elements from the Timeline/Workbench3.16 

Highlight the element(s) you want to remove using your mouse and/or keyboard. When you have made 
your selection, press the backspace key on your keyboard to remove the selected element(s).

If you select an element which is already loaded on the timeline, it will be removed from the timeline. All 
selected elements not loaded on the timeline will be removed from the workbench. Press the backspace 
key two times to delete an element which is already loaded on the timeline. It will then be removed from 
the timeline and the workbench.
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4  Control
Control

Using the Keyboard to Control just:live4.1 

It is possible to use the keyboard to control just:live using the "function keys" found at the top of most 
keyboards. However, in order to do so you must first disable any of the standard system keyboard 
shortcuts that use these function keys.

Open the System Preferences of your Mac and select the 
"Keyboard" preference pane. Make sure that the "Use all F1, F2, 
etc. keys as standard function keys" is checked. Then, under 
the "Keyboard Shortcuts" tab make sure that any keyboard 
shortcuts involving the F1 through F12 keys are disabled.

This keyboard shows the mapping of the buttons.

Load LoadNow Now

Play
VO1

F1

ctrl alt alt ctrl Arrow Keys

F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12
Play
FX1

Play
FX2

Play
FX3

Play
FX4

In-
Point

Rewind 
Preview

Stop 
Preview

FF 
Preview

Out-
Point

Sel.  
Up

Sel.
Down
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Action Key
Play FX Layer 4 (FX4) F5
Set In-Point F6
Rewind Preview F7
Stop Preview F8
Fast Forward Preview F9
Set Out-Point F10

Action Key
Load ctrl
Now alt
Play Layer 1 (VO1) F1
Play FX Layer 1 (FX1) F2
Play FX Layer 2 (FX2) F3
Play FX Layer 3 (FX3) F4

Control

Using the Contour ShuttlePRO v2 to Control just:live4.2 

If you intend to use the shuttle device (http://retail.contourdesign.com/?/products/23) please do not 
install the Contour drivers for Mac OS X. When the drivers are installed it is not possible for just:live to 
properly communicate with the shuttle device.

1
2 3

4

5

10 11

1312

1514

6 7
8

9

1 Rewind Preview

2 Fast Forward Preview

3 Stop Preview

4 Play Preview

5 Play Layer 1 (VO1)

6 Play FX Layer 1 (FX1)

7 Play FX Layer 2 (FX2)

8 Play FX Layer 3 (FX3)

9 Play FX Layer 4 (FX4)

10 Load

11 Now

12 Move Selection Up

13 Set In-Point

14 Move Selection Down

15 Set Out-Point
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Control

Using the Euphonix MC Transport to Control just:live4.3 

It is possible to use the "Euphonix MC Transport" external device. There is a standard setup for the 
device installed in the "Applications/Just Live" folder with the filename "Just Live.xml". If you have 
already installed the Euphonix software (you should have an "EuControl" icon in your menu bar to 
the left of the clock, and it should be green and not black to indicate that the MC Transport device is 
properly installed) please copy this file into the folder "/Library/Application Support/Euphonix/UserSets/
MC2User/MC_USER_SET__Root" and then restart the "EuControl" application (or restart your machine). 
Once "EuControl" has restarted you can start just:live and the MC Transport device should automatically 
work. You can use "EuControl" to reconfigure the soft key mappings if you wish. Please refer to the MC 
Transport user manual supplied with the device for an explanation of the "EuControl" application.

You can – at any time – reconfigure the MC transport for your own needs. The following shows the 
default setup.

Configuring the Number Pad

In this screenshot of the "EuControl Settings" you can see that the "+" and "-" buttons are mapped to 
move a selection up or down in the workbench.
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Configuring the Soft Keys

The six soft keys are mapped like this.
 

Load Play 
Layer VO1

Play 
Layer FX1

Play 
Layer FX3

Play 
Layer FX2

Play 
Layer FX4

Configuring the Transport Wheel

The transport wheel consists of a jog wheel, a shuttle wheel and seven keys. The jog and shuttle 
wheels are used to drive the preview in just:live (jog frame-by-frame, shuttle the preview playback 
speed between -8x and +8x speed). However, you need to assign keys to both wheels in order to 
"activate" them. Therefore the first two keys on the wheel (clockwise, left-to-right) are assigned to jog 
and shuttle. They are active by default, meaning that their LEDs will be turned on when just:live starts. 
The user can press either or both of these keys to toggle the wheels on and off. For example, if the user 
wants to use the shuttle and be sure that the jog wheel is inactive, he can press the jog button so that 
its LED is turned off and the jog wheel is deactivated. The third key is not currently assigned, the other 
four keys are "stop", "play", "set in point" and "set out point", obviously all related to the preview.
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5  Customizing The UI
1

7

8

3

5
4

2

6

In just:live it is possible to change the look and 
feel of the interface to match the users needs. 
The visibility of single windows and columns 
can be turned on or off in the "View" menu. 

1 Interface Areas
Shows or hides certain areas in the 
interface.

2 Show Engine Status
Shows or hides the engine status (buffer)
inside of the "On Air" window (only usable 
with the "Built-in Channel").

3 Show Timecode
Shows or hides the timecode inside of the "On Air" window.

4 Hidden Timeline Layers
Enables or disables the hide attribute of a particular timeline layer.

5 Static Timeline Ruler
The timeline can either be static or rolling. In static mode the timeline ruler description starts with 
zero, in rolling mode the description equals the engine time.

6 Workbench List Columns
Here you can define which columns are shown when the workbench is in list mode.

7 Docked Settings
Most parts of the interface can either be docked or undocked (floating window). When an area is 
undocked it can be moved and resized.

8 Window Layout Presets
Using the "Save/Load Window Layout Preset" commands it is possible to save the window layout 
as a file and to reload a preset on the same machine or to copy it to another machine and load it 
there. Choosing the "Reset Window Layout" will load the default just:live window positions, after 
accepting this warning dialog:
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6  Custom FX Layer Control Interfaces
In just:live it is possible to use custom FX layer control interfaces created in Apple's Dashcode. Dashcode 
is a HTML/CSS/Java based IDE to create Dashboard widgets but also iPhone and iPad interfaces. When 
creating custom interfaces with Dashcode you make use of the published input ports of a Quartz 
Composer or Composition Builder composition. A published input port can directly be accessed from 
a custom interface. A tutorial called "Just Live Dashcode Interface Design Tutorial" is available at the 
TOA helpdesk.

Custom interfaces are "published" by just:live on the local intranet on port 5000. You can use any 
browser to view and use a custom interface by entering the IP address of the machine running just:live 
followed by a colon and 5000 (e.g. "127.0.0.1:5000"). Note that for a custom interface to be available in 
this way it must first have been "loaded" in just:live by either displaying the associated graphic in the 
preview or bringing it on air.
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7  Graphic Elements
just:live supports "Quartz Compositions" (file ending "qtz"), "Composition Builder Compositions" (file 
ending "composition"), "ToolsOnAir Graphics Engine Compositions" (file ending "jscomposition"), JPEG 
and PNG files. Quartz Composer and Composition Builder files are handled differently by just:live.

Quartz Compositions
ρρ Initial duration of 30 seconds (adjustable in the inspector or in the "TOA 

Stopframes" patch)
ρρ No stopframes (unless "TOA Stopframes" patch is used)
ρρ Published input ports are shown in the inspector
ρρ Thumbnail from a random frame of the composition (unless thumbnail is 

specified)

Illegal Quartz Composer Patches

Not all Quartz Composer patches are supported by the 
just:out rendering engine, particularly the "JavaScript" patch. 
If a Quartz Composer or Composition Builder composition 
with such a patch is dropped into the workbench, a warning 
will be displayed.

Thumbnails for Quartz Compositions

It is possible to specify a thumbnail image for a Quartz file. 
Save a JPEG image in the same folder like the Quartz file and 
supply the file name with the ".thumb" extension instead of 
the ".jpg" extension. 

Example: Save an image with the name "Example.thumb" for 
a Quartz Composition named "Example.qtz" . For best results 
the thumbnail image should be 355x199 pixels.

Make sure that the extension of the file is set correctly. 
Sometimes it is not sufficient if you just replace ".jpg" by 
".thumb" in the Finder. The "Info" window of a file could still 
display the file name as "myfile.thumb.jpg". If so, remove the 
".jpg" extension.

Notes

ρρ Not every Quartz Composition works with just:live. ToolsOnAir provides no support 
for custom QTZ Plug-Ins/patches. Please contact ToolsOnAir if you need customized 
graphics development.
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Composition Builder Compositions
ρρ Duration as set in the composition
ρρ Stopframes as defined in the composition
ρρ Published input ports are shown in the inspector according to the given 

permissions in the composition
ρρ Thumbnail loaded from the composition package

ToolsOnAir Graphics Engine Compositions
ρρ Duration adjustable in the inspector
ρρ Partial stopframe support
ρρ Published input ports are shown in the inspector

JPEG and PNG Images
ρρ Drag and drop directly into the workbench
ρρ Automatic stretching of the pixel size of the image to cover the full output 

frame
ρρ It is recommended that you only use images that are properly sized for 

whatever output display mode has been selected defined for that particular 
channel

Using QuickTime Movie Files on FX Layers
ρρ Drag and drop directly into the workbench while holding down the command 

key
ρρ Automatic stretching of the movie to cover the full output frame, therefore it is 

recommended that you only use movies that are properly sized for whatever 
output display mode has been defined

ρρ Drag and drop of QuickTime movies from the library to a FX layer on the 
timeline or workbench displays a movie as if it was a "graphic", meaning that 
it will be displayed over any QuickTime movie playing on the video layer. As 
such, it makes sense to drop QuickTime movies containing an alpha channel 
into a FX layer (we recommend to use Apple ProRes 4444 movies). When a 
QuickTime movie is used as a graphic it is not possible to set an in- or out-
point
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8  ToolsOnAir Helpdesk
Administrators and users are able to use the ToolsOnAir 
online helpdesk. The helpdesk provides frequently 
asked questions, current software installations and 
more supplemental documents like user manuals and 
data sheets. You can also report bugs or submit feature 
requests to our developers and engineers.

http://support.toolsonair.com/

9  Known Issues
(1) Using a "Contour ShuttlePRO" changes the UI

When using the shuttle wheel of a "Contour ShuttlePRO" device for previewing a file in just:live's UI and 
the mouse cursor is above the workbench or above a timeline, the OS interprets the shuttle movement 
as a scrolling wheel and therefore moves the scrollbar and/or changes the scaling of the timeline.

(2) Check the validity of items does not work when loading playlists

When a playlist is loaded via just:connect, files included in the playlist will not be checked for frame rate 
compatibility or unsupported Quartz Composer patches. This could result in interrupted playout and 
therefore extra care has to be taken when scheduling playlists in 3rd party systems.
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10  Appendix
Appendix

Aspect Ratio Control10.1 

just:out provides a comprehensive aspect ratio control. The following illustrations may help you to 
understand the different options.

Playing 4:3 material in 16:9

Playing 16:9 material in 16:9

Playing 16:9 material in 4:3

Playing 4:3 material in 4:3

Pillar Box

Scale

Full Frame

V-Stretch

Full Frame

Letterbox

Scale

H-Stretch

Play 16:9

H-Stretch

Scale

H-Squeeze to Pillarbox

V-Stretch

Play 4:3

V-Stretch

Scale

V-Squeeze to Pillarbox

H-Stretch
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Appendix

VDCP Support10.2 

just:live supports basic functions using the VDCP protocol. Currently we tested VDCP devices from 
HiTech but we expect other devices using the same protocol to work properly too. We support the 
following functions:
ρρ Load (all clips in the workbench will be accessible)
ρρ Load (loads the selected video in the timeline)
ρρ Play (plays the first video in the timeline)
ρρ Stop (executes the Finished action immediately)

Make sure that the option to handle clip names with more than eight characters is enabled ("Vari Length 
ID" setting in the HiTech device) which allows you a maximum of 93 characters. Currently only the serial 
port of the KonaLHi is supported, so please make sure you are using this kind of video card.

Appendix

MOS Support10.3 

TOA supports communication with newsroom systems via the MOS protocol. This allows Octopus or 
ENPS newsroom systems to send rundowns (including video and graphics files) directly into just:live's 
workbench. In addition realtime graphics templates can be filled in the newroom system, taken over 
and played out by just:live. Please read the "TOA Newsroom integration via MOS" manual for more 
information.
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